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1 Welcome
Welcome to PicoDiagnostics, the automotive fault-finding software for your
PicoScope Oscilloscope.

With a PicoScope, PicoDiagnostics turns your PC into an automotive diagnostics tool.
The program includes a range of built-in tests that are easy to operate, even if you
haven't used them before.

If you need to go beyond the built-in tests, an additional program is available: 
PicoScope Automotive. This software will have been downloaded and installed along
with PicoDiagnostics. This gives you all the features of an advanced oscilloscope and
can be used to diagnose almost any electrical component in any vehicle.

This manual has been updated to be brought in line with release version 1.4 of the
software.

http://www.picoauto.com/software.html
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2 Introduction
PicoDiagnostics supports the PicoScope 3000 and 4000 Series diagnostic
oscilloscopes. 

Contact information  

How to use PicoDiagnostics
Getting started: see Using PicoDiagnostics for the first time . 
For further information: see descriptions of Menus .

2.1 Contact information
Address: Pico Technology

James House
Colmworth Business Park
ST NEOTS
Cambridgeshire
PE19 8YP
United Kingdom

Web site: www.picotech.com

2.2 Using PicoDiagnostics for the first time
We have designed PicoDiagnostics to be as easy as possible to use, even for
newcomers to automotive diagnostics.  Once you have followed the introductory steps
listed below, we hope that you will soon become an expert.

1. 

Plug in your PicoScope oscilloscope.  Windows will recognise it
and make the necessary changes to allow your computer to
work with it.  Wait until Windows tells you that the device is
ready to use. 

2. Click the new PicoDiagnostics icon on your Windows desktop. 

3. Click the button for the test you wish to perform.

4. 
Follow the on-screen Setup Wizards or instructions on
connecting your scope and running the test.

2

2

4

http://www.picotech.com
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2.3 Licence agreement
The material contained in this release is licensed, not sold. Pico Technology grants a
licence to the person who installs this software, subject to the conditions listed below.

Access. The licensee agrees to allow access to this software only to persons who have
been informed of these conditions and agree to abide by them.

Usage. The software in this release is for use only with Pico products or with data
collected using Pico products.

Copyright. Pico Technology claims the copyright of, and retains the rights to, all
material (software, documents etc.) contained in this release. You may copy and
distribute the entire release in its original state, but must not copy individual items
within the release other than for backup purposes.

Liability. Pico Technology and its agents shall not be liable for any loss, damage or
injury, howsoever caused, related to the use of Pico Technology equipment or
software, unless excluded by statute.

Fitness for purpose. No two applications are the same: Pico Technology cannot
guarantee that its equipment or software is suitable for a given application. It is your
responsibility, therefore, to ensure that the product is suitable for your application.

Mission-critical applications. This software is intended for use on a computer that
may be running other software products. For this reason, one of the conditions of the
licence is that it excludes usage in mission-critical applications, for example life-
support systems.

Viruses. This software was continuously monitored for viruses during production, but
you are responsible for virus-checking the software once it is installed.

Support. If you are dissatisfied with the performance of this software, please contact
our technical support staff, who will try to fix the problem within a reasonable time. If
you are still dissatisfied, please return the product and software to your supplier
within 14 days of purchase for a full refund.

Upgrades. We provide upgrades, free of charge, from our web site at
www.picotech.com. We reserve the right to charge for updates or replacements sent
out on physical media.

Trademarks. Windows is a registered trademark of Microsoft Corporation. Pico
Technology, PicoScope and PicoLog are internationally registered trade marks.

http://www.picotech.com
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3 Menus
Menus are the quickest way to get to the main features in PicoDiagnostics.  The
Menu bar is always present at the top of the PicoDiagnostics main window, just below
the window's title bar. You can click any of the menu items, or press the Alt key and
then navigate to the menu using the cursor keys, or press the Alt key followed by the
underlined letter in one of the menu items. 

The list of items in the menu bar may vary depending on which test you are running.

3.1 File menu
Click File on the Menu bar.

Load.  Allows you to load a test from disk to review the result.  Loading a test
result from disk will clear any captured data and results.

Save.  Some tests allow you to save test data to disk.

Print. Opens a standard Windows print dialog, which allows you to choose a
printer, set printing options and then print the selected view.

Print Preview. Opens the Print Preview window, which allows you to
preview the report before printing it with the Print command.

Preferences. Opens up the User Details dialog.

Exit. Close PicoDiagnostics without saving any data.

4

5
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3.1.1 User Details dialog
This dialog appears when you select Preferences on the File menu .  It allows you
to enter details about your company and your name. These will appear on the report.

How to use the dialog
Enter all the values you want.

Click OK to close the dialog and save the changes.

Click Cancel to close the dialog and discard the changes.

The items in the dialog

Company: The name of your company. This will be displayed on the report if no
logo has been selected.

Name: Name of the technician, or the contact name, to appear on the
report.

Telephone: The contact number that the customer will see on the report.

Address: The address of your company. There is space for four lines.

Logo: Your company logo (selecting a file here will enable it to appear on
your reports).

4
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3.2 Edit menu
Click Edit on the Menu bar.

Here you will find the Copy option, available only when data is shown on screen.

3.3 View menu
Click View on the Menu bar.

Details. Edit the customer and vehicle details and notes .

3.3.1 Customer details dialog
This dialog appears when you select Details on the View menu .  It allows you to
enter details about the customer and the vehicle you are testing. There is also a space
for entering notes about the test.

How to use the dialog
This dialog is for you to store data about the customer and the vehicle that the test
applies to. The data in this dialog will be saved with the test and printed on the report.

Click OK to close the dialog and save the changes.

Click Cancel to close the dialog and discard the changes.

4

4

6

6
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Customer details

Name. The customer's name.

Phone. The customer's phone number.

Address. The customer's address. There is space for 4 lines.

Vehicle details

Make. The make of the vehicle. The makes of vehicles are stored in a database. If you
manually enter a make which is not already saved, a message box will pop up.

Model. The model of the vehicle. When a make has been selected, this list is
populated with all the currently known models of that make.

Year. The year of the vehicle.

ID. An identification number for the vehicle. Can be the VIN or anything else you
choose.

Notes

In the Notes field you can enter additional information that you want stored with the
test.
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3.4 Tests menu
Click Tests on the Menu bar.

This menu lists all the tests available.  Click one of the tests to proceed.

3.5 Options menu
The Options menu changes depending upon which test you are carrying out at the
time. Please see below for links to the test options you require:

Cylinder balance options

Compression test options

Battery test options

3.6 Help menu
Click Help on the Menu bar.

These are the standard Windows options for access to this help file.

4

12

18

24

4
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4 Tests
PicoDiagnostics is a collection of specific automotive tests.  They are all designed to
be easy to use, even if you have little or no experience of automotive diagnostics.

To begin any test, click the PicoDiagnostics icon on your computer:

These tests are available with this installation of PicoDiagnostics:

Cylinder Balance

Compression Test

Battery Test

4.1 Cylinder balance
4.1.1 Cylinder balance introduction

The cylinder balance test measures how much each cylinder contributes to the
engine's total power output.  There are a number of things that can cause a cylinder
to contribute less than the other cylinders.  These include but are not limited to:

low compression
faulty injector
faulty spark plug.

A slightly uneven balance does not necessarily mean that there is a fault in the
engine.  During warm-up, most engines run slightly unevenly. Deposits and engine
wear may also have an effect on the engine's performance.  

To use the cylinder balance, start PicoDiagnostics and set the test conditions .

4.1.2 Cylinder balance test conditions
Setting the test conditions
The following test conditions must be met before running the test:

The engine must be at normal running temperature. This can be confirmed when
the cooling fan has activated twice, and by referencing the temperature gauge on
the vehicle's dashboard.
The engine must be off before connecting the oscilloscope.

If this is the first cylinder balance test you are running, load the test using the Tests
menu . Follow the on-screen wizard instructions to connect your PicoScope to the
vehicle. If however you have already run a cylinder balance test, simply click the
button labelled "Setup" and follow the on-screen wizard instructions.

9

16

21

9

8
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4.1.3 Cylinder balance wizard
The cylinder balance setup wizard consists of 3 screens. These screens are shown
below:

Screen one

This screen gives the user guidance on connecting the 
PicoScope ready for the Cylinder Balance test

Connect the oscilloscope

Connect the scope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your oscilloscope. On the
other end, connect a large red crocodile clip to the red cable and a large black
crocodile clip to the black cable. Connect the red clip to the battery positive (+) and
the black clip to the battery negative (-) as shown in the picture above.
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Screen two

On screen two, the user must identify the number of 
cylinders the vehicle to be tested has

Screen three

This screen shows the signal strength between
 the PicoScope and the vehicle to be tested.

Note: If the signal strength is low you can improve it by switching on various
ancillaries i.e. Mainbeam lights, fog lights, interior fan (full), rear demister.
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4.1.4 Cylinder balance options
This dialog appears when you click the Options... menu on the main Menu bar
while the Cylinder Balance Test  is selected.  It allows you to set special options
before running the test.

     

4.1.5 Cylinder balance test
Run the test

To start the test click the button labelled Start at the lower left corner of the window.
If the test successfully starts, a new window with a progress indicator will briefly
appear on the screen. The data is now being analysed and shown in real time on
screen with the results appearing in the bar graph as shown below.

The result
If the test could not produce a result see: Failed cylinder balance.

You can stop the test at anytime by simply clicking the button labelled Stop. It is
possible to then scan through the results by clicking the button labelled Play. The
results are always scaled to show the highest cylinder at 100%.

Cylinder balance controls
During the test you can right-click on the bar graph to get a control menu.  See: 
Cylinder balance controls.

4

9

15
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4.1.6 Cylinder balance controls
Right-click the cylinder balance bar graph to bring up a menu with display options.
You can use this menu to access more information concerning the test and its result.

Variation
Displays the variation in contribution for
each cylinder as an overlaid blue bar.

Misfire
Displays suspected misfires as a separate
bar for each cylinder.

Signal
Not required for basic testing

Brings up a second graph, the signal
graph,  that can display the engine
speed or the contribution for each
cylinder over time. To zoom in on the
data, click and drag to select the range to
display.

14
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4.1.7 Cylinder balance signal graph
The signal graph displays the captured data as engine speed or cylinder contribution.

Zooming
You can use the mouse to zoom in on the data. Use the context menu (right-click) to
zoom out again.

Signal graph context menu
Right-click the graph to bring up a menu with display options. You can use this menu
to access more information concerning the test and its result.

Zoom out
This zooms out to display the full dataset.

View
You can choose to view the engine speed or the cylinder contribution. 12
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4.1.8 Failed cylinder balance
If the test could not produce a result, make sure that:

the connection to the battery is good
the tension of the alternator belt is adequate.

It may also help if you you switch the headlights on full beam and switch on
other electrical loads, such as the rear windscreen heater and fog lights.

There are some engines for which the test has difficulties producing a result.
These include:

engines with more than 8 cylinders
some engines with dual mass flywheels
engines with inertial dampers
vehicles with xenon lights

If there is still a problem
If you have checked the points mentioned above and the software still cannot
produce a result, we would like you to send us a copy of the of the failed test
data. Please enter as much information as possible about the vehicle tested. This
is done via the Details dialog . Save the test to a file using the File | Save
menu and email the file to us on picodiagnostics.feedback@picotech.com.

6

mailto:<%LINKCAPTION%>
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4.2 Compression Test
4.2.1 Compression test introduction

The compression test is meant to be a first check.  If the compression looks good, you
can quickly move on and investigate other components which might be the cause of
the fault.  If the test detects a low cylinder, you should perform a manual compression
test to verify the results and to work out which cylinder is low.

To use the compression test, start PicoDiagnostics and click the Compression Test
button. 

 Compression test - before starting the test

There are two types of compression test:

Relative compression - requires no pressure transducer, only a connection to the
battery. 
Absolute compression - requires a connection to the battery and a pressure
transducer connected to a spark plug port. 

Follow the instructions below to connect your PicoScope to the vehicle and run the
test.

Set the test conditions
Connect the oscilloscope
Connect the pressure transducer  (only for the absolute compression test)
Disable the engine
Run the test
If the result is blank

4.2.2 Compression test conditions
Setting the test conditions
The following test conditions must be met before running the test:

The engine must be at normal running temperature, which is indicated by the
Cooling Fan switching on.

16

17

17

20
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The engine must be off before connecting the oscilloscope.
The cranking speed must be normal (battery must be charged).

4.2.3 Compression test connections
Connecting the oscilloscope
Connect the oscilloscope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your scope.  On the other
end, connect a large red crocodile clip to the red lead and a large black crocodile clip
to the black lead.  Connect the red clip to the battery positive (+) and the black clip to
the battery negative (-) as shown in the picture below.

Connecting the pressure transducer (absolute compression test only)
Remove the spark plug from any convenient cylinder.  Fit a compression hose into the
empty spark plug socket, then attach it to the pressure transducer's inlet port, as
shown in the picture below.  Then connect a BNC to BNC cable from the pressure
transducer to Channel B on your scope.  

Disabling the engine
The compression test can be done only when cranking, so the engine must be
prevented from starting. This can be done by removing the engine management relay
from the fuse box or disabling the injectors.
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4.2.4 Compression test setup
Setting up the test
The compression test should be performed according to the vehicle manufacturer's
specification.

If you are using the pressure transducer, click the Pressure button.
Next, click the numbered button corresponding to the number of cylinders in the
engine.

4.2.5 Compression test options
This dialog appears when you click the Options... menu on the main menu bar while
the Compression Test  is selected.  It allows you to set special options before
running the test.  These options apply only to the absolute compression test, and not
to the relative compression test.

Scale: The units in which the pressure sensor is calibrated.

Compensate: Check to use the Cylinder Volume, Compression Ratio
and Sensor Volume parameters.  Leave unchecked to
ignore these values.

Cylinder Volume (l): The volume of the cylinder in litres.

Compression Ratio (X:1): The compression ratio of the cylinder.  For example, if
the compression ratio is 11:1, enter 11.

Sensor Volume (l): The volume of the pressure sensor in litres.  This
information should be available from the manufacturer
of the sensor.  If in doubt, do not alter the value in this
box.

4.2.6 Compression test
Running the test

To start the test, click the button labelled Start at the lower left corner of the
window. 
A new window with a progress indicator and instructions will appear on the screen.
 Wait until the message in the window is "Crank engine".  
With the throttle wide open (accelerator pedal fully pressed), crank the engine until
the progress indicator reaches 100%.  

18
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The data is now analysed and the result appears in a bar graph, as in one of the
examples below:

Compression test result -
without pressure sensor

(relative mode)

Compression test result -
with pressure sensor

(absolute mode)

In relative compression mode, the
result is always scaled to show the
highest cylinder at 100%.  The bars are
ordered according to the engine's firing
order. The cylinders are named A, B, C
and so on, because with only a
connection to the battery the software
has no way of knowing which cylinder
is number one.  This may cause the
result to be shifted if you run the test
on the same engine more than once.

In absolute compression mode,
PicoDiagnostics shows the true
compression in each cylinder. As in
relative compression mode, the bars
are named A, B, C and so on.

The result
If the test could not produce a result, see Failed compression test .20
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4.2.7 Failed compression test
If the test could not produce a result, make sure that:

the connection to the battery is good
there is not a battery charger connected to the vehicle's electrical system.

If there is still a problem 
If you have checked the points mentioned above and the software still can't
produce a result, we would like you to send us a copy of the of the failed test
data. Please enter as much information as possible about the vehicle tested.
This is done using the Details dialog . Save the test to a file using the File |
Save menu  and email the file to us at
picodiagnostics.feedback@picotech.com.

6

4

mailto:picodiagnostics.feedback@picotech.com
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4.3 Battery Test
4.3.1 Battery test introduction

To use the battery test, start PicoDiagnostics and click the Battery Test button.  

Tip: If the battery has been recently charged, there is a risk of “surface charge”
affecting the state-of-charge results.  To eliminate the surface charge, switch the
lights on full beam for about 2 minutes and then wait for about 2 minutes before
performing the test.  If you are only measuring cold cranking amps then you can
ignore this precaution.

Follow the instructions below to connect your PicoScope to the vehicle and run the
test.

Connect the PicoScope
Set any special test options
Run the test
If the result is blank

24

26
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4.3.2 Battery test connections
Connect the PicoScope
Connect the PicoScope to a free USB port on your PC using the USB cable.

Connect one of the general test BNC cables to Channel A on your PicoScope. On the
other end, connect a large red crocodile clip to the red lead and a large black crocodile
clip to the black lead.  Remove the cover from the fuse box. Connect the red clip to
the battery positive (A+) and the black clip to a secure earth or ground point (A-) as
shown in the picture below.

Battery test connections:
A– : Ch A ground (black) clip
A+ : Ch A positive (red) clip

B : current clamp

Connect the 600 A or 2000 A current clamp to Channel B on the PicoScope. Place the
amp clamp (600 amp clamp for light vehicle applications or 2000 amp clamp for
heavy duty applications), so that it is positioned around the positive cables which are
connected to the positive battery terminal. More importantly make sure the amp
clamp is positioned around the starter motor feed cable (main positive cable from
battery to starter motor).

If you have a 4-channel scope then you can run the optional extended drop test.

Additional connections for extended drop test

In addition to connecting channels A and B as described above, channels C and D
must also be connected as follows:

Channel C: Using a BNC to 4 mm lead, connect the red 4 mm plug to the positive
terminal of the starter motor using the appropriate clip / connector. This is the
terminal that the main positive cable from the Battery Connects to.

Channel D: Using a BNC to 4 mm lead, connect the red 4 mm plug to the negative
terminal of the starter motor using the appropriate clip / connector. 
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Note: Most modern vehicles don’t have earth cables to the starter motor. In this case
connect to one of the mounting bolts by which the starter motor is attached to the
engine or gearbox bell housing, as the starter will earth through to chassis and/or
battery.

This will enable PicoDiagnostics to separate the cable resistance from the starter
motor resistance.

All connections must be clean and free from oil, grease and dirt to ensure the readings
are accurate.

4.3.3 Battery test setup
First, click either the 12 V or the 24 V button depending on the voltage of your
electrical system.

Tip: If you have a 24 V system with two 12 V batteries, test each battery separately.
 Otherwise one good battery could hide a fault in the other battery.

Next, set the temperature control to the local air temperature in degrees Celsius.

Now, set the battery test options (see Battery test options ).24
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4.3.4 Battery test options
This dialog appears when you click the Options... menu on the main menu bar while
the Battery Test  is selected.  It allows you to specify the characteristics of the
battery before running the test. Refer to battery manufacturer's specification for CCA
and Ah figures.

Change any options in the Battery Test Options dialog  that are different from
the standard test

Battery capacity (CCA): The battery capacity in cold cranking amperes.

Battery capacity (Ah): The battery capacity in ampere-hours.

Click OK to confirm

23

24
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4.3.5 Battery test
Click the Start button in the bottom left corner of the window.  

Note: Because the engine is not drawing any current at this stage, the program
will draw a horizontal line showing zero amps of current.  If this line is not at zero
amps, the current clamp may need to be adjusted.  Press the "Zero" button or turn
the "Zero" dial on the clamp until the horizontal line is at zero amps.

Start the engine.  

While the test is running, the program shows the voltage on Channel A and the
current on Channel B, and a graph is drawn from left to right.  The program
automatically stops recording data when it has enough information, so there is no
need to click the Stop button unless you wish to stop the test early.

The program then analyses the data and shows the results in a table, as in the picture
below:

If the program reports "Battery has failed the test - refer to help file for advice", see 
Interpreting the Results .26
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4.3.6 Battery Test: interpreting the results
If the state of charge is low then recharge the battery and re-test.

If the state of charge is all right but the CCA (cold cranking amps) is low then check
these things before replacing the battery:

Check the battery connections.  If they are loose, they could increase the internal
resistance.

If the battery is not a sealed type, check the fluid levels in each cell.
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Pico Technology
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United Kingdom
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